
Welcome

Welcome to Multimedia Xplorer! This is program that combines several tools into one easy to use shell. 
These tools are:

 Image viewer and converter for most used file formats
 Media Player for playing sounds and videos
 Enhanced file manager
 File finder called Multimedia Detective
 Slide Show editor/player
 Batch Converter for converting large number of images from one format to other at once
 Image printing with preint preview.

In addition to having these tools all in one program, Multimedia Xplorer has some unique ergonomic 
features that make it very comfortable to browse/manage your image, sound and video collections.

You will get most out of this help file if you browse it with [<<] & [>>] buttons on the help window toolbar. 
Then you read it like manual. Of course you can use the index or topics window to get quickly to the 
topic of interest.

This help file describes functionality of full and shareware version of Multimedia Xplorer. There are also 
Lite and SE versions that have some functions disabled. Those special versions are usually bundled 
with other software programs or hardware and you cannot download them form the Internet. Look at the 
differences between   Lite   and full version  .



Features

Multimedia Xplorer has the following main features:

 easy to use interface, similar to Windows Explorer
 built-in file manager with advanced features 
 displays images in the following formats: JPEG, GIF, TIFF, BMP, TGA, WMF, EMF, PCX, DCX, ICO, 

CUR
 zoom bitmap images
 converts bitmap formats to JPEG, GIF, PNG, TIFF, BMP, PCX
 SUPERFAST JPEG decoding
 smart handling of overcompressed JPEG images from the WWW
 printing with print preview
 powerful batch conversion for converting large number of images from one format to other (supports 

thumbnail creation)
 plays the following sound formats*: WAV, MID, RMI, AIFF, AU, SND, MP2, MP3, M3U, MPA, RA
 plays the following video formats in it's own display area; doesn't open any additional windows for video 

output: AVI, MPEG, MOV, RM
 shows and allows the extraction of icons from ICO, ICL, DLL, EXE to any supported conversion format
 extracts selected icons at once from EXE, DLL, ICL etc.
 lets you browse your animated cursor (ANI) files and turns your mouse cursor to selected ANI.
 you can see all images from multiimage ICO file at once
 clipboard, print, convert functions allow you to select image from multiimage ICO file
 convert any bitmap image to proper 320x400 256-color image used in startup and shutdown screens.
 Windows startup & shutdown logo changer, with live preview
 uses amazing dithering - true color images have a true look even in 256-color mode
 unique Favorites for saving your most used folders for quick access
 unique Destinations stores the folders you copy/move files into most often
 special One-Click Destinations toolbar allows you to copy/move files to pre-defined folders with a 

single mouse click when sorting large file collections
 unique "Run With" menu allows quick access to the programs that you use most frequently to 

edit/manipulate images
 unique File Filter lets you define filters to show only the file types you choose
 built-in slide show editor with many features
 displays manual or automatic slide show
 drag & drop support from Windows Explorer
 full support for shell context menus
 unique Multimedia Detective searches through the drives/folders you select for multimedia and image 

files and then displays results so you are one click away from accessing these files
 mark files by tagging during slideshow or in Explorer and operate (copy/move/delete/convert etc) with 

tagged files later, all at once. Tagged files are optionally displayed with another color in the Browser
 set any image as tiled, centered, stretched or positioned desktop wallpaper

and much more...

(*) All sound and video files require fully functional MCI drivers not provided with this program.



Requirements

System requirements for Multimedia Xplorer:

 Windows 95, Windows 98, Windows NT 4.0 or newer
 ~ 2 MB free disk space
 256-color or higher display mode (true color recommended)
 sound card for sounds and music (optional)
 MCI drivers for additional multimedia formats like MOV, MPEG, AU, SND, AIFF, MP2 (optional)

NOTE: Multimedia Xplorer will run even in 16-color mode, though the quality of images is very poor. 
Multimedia Xplorer supports very good image dithering in 256-color mode, that displays true color 
images (with 16 million color) with good quality, but it takes additional time to dither the image. For high 
speed viewing of true color images, it is recommended that you use a graphics adapter capable of 
displaying graphics in high color or better. This will save you about 1/3 of the loading time.



Performance

It's recommended that you use high or true color display mode. That ensures that Multimedia Xplorer 
can display images with the fastest possible speed on your PC and also you'll see them with maximal 
quality. If you use only 256 colors, then it takes more time to display image, since Multimedia Xplorer 
needs to create a palette for each image. Also, since the palette is available only after image is fully 
decoded, you see image with wrong colors until it's fully decoded.

If you are interested to change your display mode but have no experience, please see little guide in the 
Troubleshooting section.



How Multimedia Xplorer plays sound and video files

If you wish to use Multimedia Xplorer to play multimedia files (sounds and videos), you need to 
understand how Multimedia Xplorer generally works with them. Multimedia Xplorer doesn't contain 
native support for those file types. That means it doesn't contain any code on how to decode a video 
stream in specific format. If it contains all the code for all the formats it supports, then the program size 
itself could be several times larger. Instead, it uses Windows "service" called MCI to play those files. 
MCI stands for Media Control Interface. Now on how the MCI works. Several manufacturers have MCI 
drivers that handle their file formats. This driver is registered with Windows, so if a program wants to 
play that type of files, it can do this via MCI commands. The program that wants to play the file doesn't 
need to know, how this is done at low level. Instead, it tells Windows, through MCI commands, that "I 
want to play this file in this window at this position". And the driver that understands those standardized 
command, will open the file and play it for us. There are many commands that can control the playback, 
like commands to start, stop, pause, rewind, close, set size and position etc.

Now, where the problems can arise? Yes, actually there are some problems and limitations associated 
with MCI. First, MCI is an old standard from the ages of Windows 3.1. And, it's maintained mostly for 
backward compatibility with old apps. There can be only one driver associated with a file type, so 
several programs may overwrite the file type association. That should not be a problem, if all the drivers 
work great. But unfortunately there are some drivers that don't support some commands and others that 
are buggy and cause a client program to crash. That's why it's important to associate multimedia file 
types with a reliable driver, that actually plays, not only tells it plays specific files. An example is the MCI 
driver that ships with QuickTime and associates itself with MOV files by default. It just doesn't work.

Currently one of the most reliable driver is one that ships with Microsoft Media Player update. 
Multimedia Xplorer is developed to use the services Media Player can provide, so it's recommended that 
you use it if you want to play all the types Multimedia Xplorer supports with minimum mess.

So, you cannot play all the multimedia files with Multimedia Xplorer if you have no drivers. If you have 
Windows98, you have less problems, since the ActiveMovie is installed automatically. But you may find 
that downloading a new, updated Windows Media Player will help you much too. Please see the topics 
at the end of chapter if you are stuck with the drivers.

In the future Multimedia Xplorer probably uses DirectShow to play multimedia files, so the MCI driver 
problems are not actual then. Unfortunately currently DirectShow seems to be quite slow opening small 
files, but let's see what the future brings.

See also:

How to obtain MCI drivers
ActiveMovie Repair Wizard



Getting Help

You can get help in windows by pressing the F1 key on the keyboard, or if available, pressing the 
Help button. In several dialogs where you see the  button in the dialog's title bar, you can press this 
button and then select the particular item you want help with.



Starting Multimedia Xplorer

You can start Multimedia Xplorer by double-clicking on its icon on your desktop, OR:

 you can drag supported file into it's icon on desktop and release mouse button, which runs Multimedia 
Xplorer and opens the dragged file in it

 if you have associated some file types with Multimedia Xplorer in the configuration dialog, you can 
double-click on these file types in Windows Explorer, which will then run Multimedia Xplorer and open the 
clicked file. If you already have a copy of Multimedia Xplorer running and you double-click on file in 
Explorer, new file is opened in existing Multimedia Xplorer window.

 you can automatically start playing saved Multimedia Xplorer slide show script (*.MXS) by double-
clicking on them in Windows Explorer



Browsing and viewing files

Multimedia Xplorer window is similar to Windows Explorer - directory tree at left side and file list at right. 
If you are familiar using Windows Explorer, you'll find that most of it's functionality is supported by 
Multimedia Xplorer, including but not limited to: file/folder context menus, drag and drop, keyboard 
shortcuts (F2 - rename in place, Ctrl+C - copy files, Ctrl+X - cut files, Ctrl+V - paste files, Backspace - 
previous folder etc).

To view files, you just need to click on file and it will be displayed in display area. You can use file 
operations on open or selected file. You can also select multiple files at once. If multiple files are 
selected, open file is closed. BTW, operations like Batch Conversion and Batch Rename work only if 
multiple files are selected - there are no separate command for invoking those functions, but if you have 
selected more than 1 file, and invoke the Rename function, Batch Rename is automatically called.

You can browse through your files also by arrow keys. If you don't want to open certain files while 
browsing with arrow keys, hold down Ctrl key while highlighting it.

NOTE: Don't forget you'll see file context-menu if you right-click on file in file list. That way you can use 
your favorite applications and shell extensions from within Multimedia Xplorer, like WinZip, MS 
PowerToys, Targets etc.



Toolbar Buttons

 Copy
Copies open image or selected icon to the clipboard. You can then paste clipboard contents to any 
Windows application that supports pasting from clipboard as picture.

 Close
Closes the open file, if any. It is recommended, that when you have large images or videos open and you 
are going to minimize Multimedia Xplorer, you close the file before minimizing; otherwise it takes up a lot 
of memory that your other programs may need. You can use the Esc key as shortcut.

 Print
Opens printing window and allows you to print open image.

 Convert
Clicking this button opens the Convert dialog, which allows you to convert the open image to any 
supported format.

 Open & Play Slideshow
Allows you to open a saved slideshow file (*.MXS) and start showing it.

 Create/Edit Slideshow
Opens Slideshow Editor, where you can create new or edit existing slide show script.

 Logo Changer
Opens Logo Changer, that lets you change images of Windows startup & shutdown screens.

 Multimedia Detective
Displays Multimedia Detective. You can use Multimedia Detective to find all supported multimedia and 
image files in any folder and on any drive.

 Manage
By clicking this button, a popup menu appears. Commands on menu are used for file management - here 
you can copy/move/rename the open file. The popup menu also has the powerful Destinations submenu, 
where all the directories you use most frequently are listed.

 Delete
The delete button deletes the selected file(s) from the disk.

 Run
Displays Run With menu.

 Properties
Displays standard file properties dialog with file information. You can also change file attributes there.

 Tag/Untag File(s)
Adds selected file(s) to the list of tagged files. You can then operate with all tagged files at once later. If 
one file is selected, the buttons acts like toggle - if file is already tagged, it's down. To untag the file, press 
it again, so it pops up. To untag multiple files at once, right-click on the button.

 Color Tagged Files in Browser
Allows you to see tagged files in browser, marked with different color. You can choose the color in the 
Options dialog.
NOTE: If this option is set, file list will be filled and repainted slightly slower. You may need to switch this 
function off if you have tagged many files and displaying filenames in browser seems to take long time.

 Show Tagged Files
Displays Tagged Files dialog, where you can manipulate with tagged files. Right-click to clear Tagged 
Files list fast.

 Favorites
Displays Favorites, folders that you use most frequently. Choose folder from the list to browse that folder.

 Full screen
Uses the full screen to display the open image. You can also double-click on image to display it full 
screen.

 Quick Show
Initiates a Quick Show. Right-click to display the Slideshow menu.



 Filter

Displays popup-menu with file filter commands. Right-click to activate All Supported Files filter.

 Zoom
Displays Zoom popup menu.

 Fit Image
Sets fit image mode on and off. When fit is on, all images that are larger than the display area are scaled 
to show completely. When fit is off, then you can see only part of large image, but the image is not scaled 
and is shown 1:1.

 Fit Video

Sets fit video mode on and off. When fit is on, all videos that are smaller than the display area are 
stretched to show in maximum size. When fit is off, then you can see video 1:1.

 One-Click Destinations
Displays or hides One-Click Destinations floating toolbar.

 Media Player
Shows/hides integrated Media Player. That has effect only if sound or video file is open.

 Details

This button controls whether you see simple or detail file information in browser.

 Options
Displays the Options dialog, where you can configure Multimedia Xplorer.

 Most actions you can choose from the toolbar also have shortcut keys for quick access. Look Shortcut 
Keys for more information.



Selecting Files

If you are familiar with the Windows Explorer, then selecting files should be no problem. 

 To select multiple files, select first file and while holding down the Ctrl key, select other files by clicking 
on them

 To select all files in browser use the Ctrl+A key combination or from the Edit menu -> Select All.
 To select continuous block of files, select first file and while holding down the Shift key, select last file. 

This selects all files from first to last.
 To invert selection, use the Invert Selection command from the Edit menu.

 You can also select files by dragging "bounding box" abound them with mouse.



File Management

To copy/move/rename/batch rename/delete file(s), follow these simple steps:

 Select file(s) you want to manage.
 Press the 
 button on the toolbar and a little file management popup menu will appear.
 Choose the appropriate command from the popup menu.

You can also use Windows Explorer shortcut keys to manage files (to make this work, you must have 
file list focused):

copy file(s) - Ctrl+C
cut file(s) - Ctrl+X
paste file(s) - Ctrl+V
delete file(s) - Del
rename single file in place - F2

 Be sure to check out how to use the Destinations menu - a set of folders defined by you that allows 
you to copy/move files to folders you use frequently with a single click.

 Multimedia Xplorer allows you to rename multiple files at once, so you can easily create series like 
file001.ext, file002.ext … fileNNN.ext.

 When renaming single file, you don't need to type extension part of filename if it will be the same as 
original one.
NOTE: For delete and move operations, Multimedia Xplorer uses your current Recycle Bin settings while 
deleting files. If you have turned delete confirmation off, you will not see a delete confirmation dialog. You 
can configure immediate delete instead or removing files/folders to Recycle Bin in General tab in Options 
dialog. If you hold down the Shift key when choosing the Delete command, files are deleted immediately 
instead of removing them into Recycle Bin.



Viewing Multimedia Files

You don't need to take any special action to play multimedia files. You open them as you do with image 
files, simply by clicking on the filename in the browser.

If sound or video file is opened, small built-in Media Player is visible above the file list (optional). See 
Media Player for more information.

 Videos can be displayed original size or zoomed (stretched) to the full display area using correct 
aspect ratio. To switch stretching ON and OFF press the 

 button.



Using built-in Media Player

Multimedia Xplorer has a built-in media player that gives you more control over playable files.

 To display or hide the player, press the 
 button on the toolbar. Please note that player is visible only if sound or video file is opened.

Built-in Media Player functions just like the one in Windows. You can use the buttons to play, pause, 
stop, jump to start/end, fast forward and rewind the open file. To go to a specific position in long file, you 
can drag the little node that displays current progress.

If you would like to play your media file continuously, you can use repeat mode. To switch repeat mode 

on or off, use the  button in Media Player. Then if file ends, Media Player will rewind it and starts 
playback again. Please note that this may not work with all files.

Another feature Media Player offers is adjustment of video speed. This is useful if you want to see video 

faster or slower than actual playback rate is. Press the  button to see speed adjustment trackbar. You 
can adjust video speed by dragging the slider. 100 is actual playback rate and 200 is double speed. To 
return to the actual playback rate quickly, press the Default button in speed window. Also, to return to 
default playback speed without opening speed slider window, right-click on the 

 button.

 To step video forward or backward by one frame at a time, hold down the Ctrl key while clicking on 
stepping buttons. By default it steps 10% of video length if no Ctrl key is down.

 To quickly set video speed back to 100% (default speed), right-click on the 

 button.
NOTE: Depending on of what kind of MCI drivers you're using, fast forward and rewind buttons or video 
speed adjustment may not function properly. This is because some drivers do not support this 
functionality.



Obtaining MCI Drivers

We recommend to download and install the Windows Media Player update. This way you'll get a new, 
cool Media Player that can play files directly from the 'net and also locally. And it supports most recent 
multimedia files, including MP3, RealAudio, RealVideo etc. Also there are more file types available as 
the time goes.

Please visit the Media Player homepage to download a copy for Windows95/98 or Windows NT:

http://www.moonsoftware.com/cgi-bin/redirect.exe?mplayer_download

If the above doesn't work, try:

http://www.microsoft.com/windows/mediaplayer/download/

or you can find a link from the Multimedia Xplorer homepage.



Converting Images

You can convert your open image to other graphics format or to Windows startup & shutdown logo file.

Converting images has usually reason. For example you want to view images you get from web page 
with some program that only accepts Windows Bitmap (BMP) file format. Then you can convert your 
JPEG/GIF image into BMP. Or you may want to reduce colors from 16 million to 256-colors, so image 
files take much more less space. If you have true color photos for viewing then you can save a lot of 
disk space if you store them as JPEG images. For example true color 800x600 image in BMP format 
takes about 1.4 MB disk space, but converting it to JPEG, it takes only 60 KB - that's about 23 times 
less!! So, you can put 1 true color 800x600 BMP image onto 3.5" diskette or 23 of them in JPEG 
format…

You have also option to resize image when converting.

To convert file(s):

 Select file(s) you want to convert
 Press the 
 button on toolbar, or choose the Convert command from the File menu or use Ctrl+S keyboard 

shortcut. If you have selected 1 file, Convert dialog will pop up, if you have selected more then 1 file, 
Batch Conversion dialog is opened.



Converting Multiple Files At Once

Batch conversion is useful for converting multiple files at once. For example you may have folder full of 
Windows bitmaps in BMP files and also some files in other formats. You want to convert all these files to 
GIF format for using in your web site. All you must do is select these files you want to convert, specify 
target file format, color depth and folder, where you want to put converted files and hundreds of files can 
be converted without bigger mess. You can also use this functionality to resize multiple images at once, 
for example generate thumbnails of bigger images.

 Select all the files you want to convert (if you want to convert files from multiple folders, you should tag 
them first with the Tag File function)

 To open batch conversion dialog, choose Convert from the File menu ot click on Convert button on the 
toolbar or use the Ctrl+S keyboard shortcut.

 You can extract selected icons from EXE, DLL, ICL etc file by choosing the Extract Icons command 
from the File menu.



Setting and Removing Desktop Wallpaper

You can set any bitmap image as your desktop wallpaper. To set a new wallpaper do the following:

 Select open image that you want to set as your new wallpaper.
 Choose Wallpaper from the File menu and pick either Tile, Center, Stretch or Position from the 

submenu. Tile tiles the image over the desktop while center centers a single image on the desktop. 
Stretch* stretches your image to fill entire desktop and Position** will open additional window, where you 
can drag your image into the right position.Your wallpaper image is saved to your Windows directory with 
the filename Multimedia Xplorer.bmp.

 To remove your current desktop wallpaper, choose Remove from Wallpaper submenu in the File menu.
 You can also set wallpaper by commands in the popup menu of image.

*) Please note that the Stretch command is only available when Microsoft Plus! or Microsoft Font 
Smoother is installed, i.e. you see the Plus! tab in display properties, or you are running Windows98.
**) Starting from the version 2.0.6 the Position Wallpaper command works with Windows 98 too. But keep 
in mind that MX creates wallpaper with the size of your entire screen, paints it with the background color 
and then draws your image on specified position. That is workaround since Windows 98 doesn't support 
wallpaper on specified position as Windows 95 did. Since many people have asked this feature, I decided 
to realize it that way. Desktop pattern, if you have one, is not drawn and also the Tile checkbox is not 
available in the Position window.



Associating Files With Multimedia Xplorer

You can associate file types with Multimedia Xplorer. This allows you to view an image by double-
clicking on the filename in Windows Explorer. To associate some or all image types supported by 
Multimedia Xplorer, follow these steps.

 Open Options dialog.
 Select Associations tab.
 Check the image types you want to associate with Multimedia Xplorer.
 Close Options dialog by pressing OK.



Icon Files

Icon files are small stand-alone image files (ICO) or embedded into program files. Most programs 
display it's own icon in Windows Explorer or on Desktop, so this icon resides inside the program 
executable file. In Windows 95 or newer, icon files may contain several images - each one designed for 
specific display resolution/color depth. You may see different icons for a program in Explorer Large 
Icons view or in Small Icons view. If you open icon file that has more then 1 image inside, you see all 
images in row. By trying to copy/save/print the icon, you will be asked to specify, which image you would 
like to manipulate. You have also option to generate image strip from all images.

Multimedia Xplorer lets you perform several actions with icon files:

 You can simply view standalone icon files (with extension ICO) like you do any other graphic image. 
You can see all images that are inside an ICO file, not as with most other programs, that show you only 
the first image.

 you can view icons inside program files (EXE), dynamic link libraries (DLL) and icon libraries (ICL) and 
Extract (select icon -> File menu-> Extract Icon command) them as a standalone icon file with the 
extension ICO. Currently Multimedia Xplorer only supports extracting single-image, 32x32 pixel, 16-color 
icon.

 you can Convert (select icon -> File menu-> Convert command) a standalone icon or icon from a library 
to any of the supported graphic formats (JPEG, BMP, GIF, PNG, TIFF, PCX)

 you can Copy (select icon -> Edit menu-> Copy Image command) an icon to the clipboard as a bitmap 
from any source above (e.g. ICO, from DLL, EXE, ICL)

 Try opening moricons.dll or explorer.exe in your Windows directory (generally C:\Windows) and 
shell32.dll or iconlib.dll in Windows\System subdirectory.

 The easiest way to copy an icon from library (EXE, DLL, ICL etc) to clipboard is double-click on it. This 
won't work for ICO files, which are displayed full screen if double-clicked.
NOTE: Multimedia Xplorer only saves icons that have a single image. It ignores other images with 
different sizes and color resolutions in icons. If you want to extract icons that contain both small and large 
icons (PE icons), you must use one of several special programs, like MicroAngelo™ from Impact 
Software.



Printing

Multimedia Xplorer allows you to print images and icons. To display printing dialog, press the  button 
or choose the Print command from the File menu.

To get more information about items in the Print dialog, press the  button in the title bar and then select 
the item of interest.
You can see print preview in the Print dialog. You image will be printed as you see it on the preview. You 
can see also blue margins on preview. These are margins that show unprintable area of printer. Any part 
of image that remains outside of these margins, is not printed. If part of image is outside margins, the 
margin is displayed with red color. Then you know that something is "around" the margins.

To print image on center of page with average size:

 Check Fit to Page checkbox. Max Image Size must be unchecked.
 Into the Margins box write 1 (if you are using inches) or 25 (if you are using millimeters).
 Check Print Title checkbox if you want the filename printed at the bottom of page.
 Press the Print button to print the image.
 To change paper format, orientation and other printer settings, use the Setup button.



Logo Changer

Logo changer lets you change your Windows startup & shutdown screens. For example you can replace 
these screens with your own images. You can also create logo sets.

Logo files used as startup & shutdown screens have extension SYS. They are actually standard 
Windows bitmap files (BMP), but have 256 colors and size 320x400, so they are not proportional 
compared with screen. 

Location and names of logo files:

startup* logo.sys in root of boot drive
shutdown logow.sys in Windows directory
close logos.sys in Windows directory

*) startup logo file doesn't exist in standard Windows 95 (without Plus!), but if you place your own file named 
logo.sys in root directory of your boot drive, it will be used instead of standard "blue sky" screen.

Multimedia Xplorer eliminates all mess with replacing logo files with your own images. You simply select 
what image you want to use and it is automatically converted to 256-color, 320x400 file and is placed to 
proper location.

 To run Logo Changer, press the 
 button on toolbar or keyboard shortcut Ctrl+L. Your current screens are displayed. To get help in Logo 

Changer window, press the 
 button in the window title bar and select item.
 Multimedia Xplorer allows you to browse your collections of startup and shutdown screens. For this, 

you must allow displaying of *.SYS files by activating file filter that allows display of *.SYS files.
 If you want simply convert any image to such logo SYS file, use Multimedia Xplorer's Convert function 

and choose last file type. This converts your open picture to 256-color 320x400 image, suitable for use as 
such logo.

Note: Custom startup & shutdown screens are NOT available on Windows NT.

See also Logo Sets.



Logo Sets

Logo Changer allows you to create logo set files (*.MXL). That's useful when you want to replace all 3 
logos with a theme for example. You have already prepared logo set file and now load it and that 
replaces all 3 logos at once. 

To make a logo set, open Logo Changer and:

 Choose image for each logo, if you don't want to load image, leave blank.
 Press the Save Set button and choose filename for your logo set. If you don't want to store full path to 

logo files, uncheck the Include Full Path to Logo Files checkbox in Save Set dialog. This is useful if your 
actual image files are in the same folder as the set file. This way you can give the logo set file with images 
to your friend and there is no problem with different folder names.

Please note that logo set file contains paths to images you have chosen. If you save set and have not 
chosen images that are different from your current logos, then filenames of your current logos are 
saved. That is not the idea. 

 To see logo set files in Logo Changer, change Files of type filter to display logo set files and click on the 
filename you want to load.

More about logo files.



Multimedia Detective

Multimedia Detective is a program to help you find all directories that contain image and multimedia files 
in a specified drive or folder. For example imagine, that you have some CDs with a lot of different kind of 
stuff there, and you want to find every multimedia piece on this CD. There may be a lot of cool stuff 
deep in some subdirectories! You don't have to take an hour or two to manually dig through all the 
directories; just run Multimedia Detective (View menu -> Multimedia Detective), select the drive/folder to 
search and bingo! - you now have a list of all the multimedia and image files on the CD-ROM. You never 
would have imagined that there would be so much interesting stuff...

See also Using Multimedia Detective.



Using Multimedia Detective

To open the Multimedia Detective window, click the  button on Multimedia Xplorer toolbar or choose 
Multimedia Detective command from the View menu. 

To select a folder/drive to begin your search press the  button. This displays a dialog window, where 
you can select the drive and folder you want to search. After selecting the drive and folder, Multimedia 
Detective starts searching. Please note that you can still work with Multimedia Xplorer at the same time, 
because scanning uses separate thread and it doesn't block the application (it's slower, though). If you 
want to stop searching for some reason, you can press 

 button.

When the search is finished, you can see the results, grouped by category of media: images (JPEG, 
GIF, TIFF, PNG, BMP, PCX, WMF, EMF), videos (AVI, MPEG, MOV), sounds (WAV, AU, SND, AIFF, 
MP2), MIDI music (MID, RMI) and icons (ICO). At the end of the caption in parentheses is the number of 
files from this category found in the specified location. If the number is bigger than 0, you can double-
click on the caption to open a "branch" and see the folders that contain files with the specified file type. 
Now you can double-click on any folder to see, how many files this folder holds. And, most important, if 
you double-click on a list of files, or choose Browse from the popup menu, you can change Multimedia 
Xplorer's browser to this location, so you can explore these files.

If you want to open Windows Explorer in the directory of interest, choose Browse with Windows Explorer 

from the popup menu or use the  .

If you need to rescan or continue stopped scanning of a folder/disk, press the  button.

Also try expanding the whole tree by choosing Expand Tree from the View popup menu item, or the  
button. To "close" a tree, choose Collapse Tree or 

.
 If you have a lot of directories to browse, try maximizing the Multimedia Detective window. In the 

maximized state it occupies only half of your screen, so you can switch between Multimedia Xplorer and 
Multimedia Detective with ease.

 If you have changed your Multimedia Xplorer browser to the specified folder and can't see any files of 
this type there, make sure the file filter that prevents showing specified type of files is not active.



Slideshow

Multimedia Xplorer has powerful features to view bitmap graphic files as slideshow and also to create 
slideshow scripts.

QuickShow

You can view files that you have filtered like a slide show. To do this, press the  button on the toolbar 
or choose the Slideshow -> QuickShow menu command and the show begins. You can also use F8 key 
to start the QuickShow.

You can also choose other QuickShow options. If you look into the Slideshow menu (right-click on ) you 
see other choices like QuickShow with Subfolders and QuickShow Selected Files. First shows all 
displayable files in the opened folder including all it's subfolders. Latter includes only selected files in 
show, but if there are no files selected, you'll see all filtered files (calls usual QuickShow).

Creating/Editing Slide Show

There is a slide show editor used for creating, editing and saving slide shows. It has some additional 
functions like preview, shuffle, remove duplicates, remove non-existing files from show, change 
paths/drives and others.

To display the Slideshow Editor, press the  button on the toolbar.

Opening Slide Show

You can open and play back a slideshow file (*.MXS) you have saved by pressing the  button on the 
toolbar or by choosing Open & Play Saved Slideshow command from the Slideshow menu. After 
choosing the desired file in open dialog, the slide show is automatically started

 You can configure slideshow options in Options dialog, Slideshow tab.
See also Controlling Slideshow at Runtime topics.



Controlling Slideshow at Runtime

At run-time you can control show execution from the popup-menu or by pressing the shortcut keys.

You can also tag files at show time, so you can manage them later, after show.

The following shortcut keys apply to slideshow:

automatic/manual show A

zoom in/out numpad +/-

default zoom numpad *

tag/untag file T

show/hide file information I

repeat mode on/off R

random mode on/off N

end show Esc

next slide spacebar, Enter, Right Arrow, Down Arrow

previous slide Left Arrow, Backspace, Up Arrow

increase/decrease slide 
display time by 1 sec Ctrl + numpad +/-

increase/decrease slide 
display time by 10 sec Ctrl + Alt + numpad +/-



What Is Filter?

Multimedia Xplorer lets you filter files. You can filter out the file types you don't want to see in the 
browser, so you can concentrate to your work, not to be disturbed by unwanted file types. Using a filter 
is useful when you have many files of different types in one folder, but only want to see files of a certain 
type. For example, if you wanted to see only sound files, you could define a filter, that contains only 
sound file types. You can specify to show only files with extensions WAV, SND, MID, etc and hide all 
other types.

There are already defined generic filters like: image files, sound files, video files, icon files and cursor 
files. In addition there are All Files filter and All Supported Files filter already defined.

You can define your own filters that display only subset of files. There are 2 ways for that - QuickFilter 
and Custom Filter. 

To activate filter, take these steps:

 Press the 
 button to display Filter popup menu.
 Choose the filter you would like to use.
 Please note the key combinations, visible in menu, you can use with predefined filters.
 You can also start Multimedia Xplorer with the last used filter enabled. For this you need to check the 

Use last filter next time checkbox in the Options dialog General tab.



Favorites

The Favorites are directories you most frequently use for browsing.

If you have certain directories where you store images, sounds, videos, icons etc., it's a good idea to 
add them to the Favorites list. Then you can change to your favorite directory with a single click.

 To add the currently open directory to the Favorites, choose the Add Current Folder command from the 
Favorites menu. You can display the menu also by clicking the 

 button.
 To edit the Favorites contents, choose Organize Favorites from the popup menu. This lets you add and 

remove multiple directories at once.
 There are also shortcut keys available for the above actions.



Destinations

Destinations are folders you use most frequently to copy/move files to. By selecting folder name in 
Destinations submenu, you simply say to Multimedia Xplorer to copy or move file to this folder. So you 
don't need to spend time for browsing the same folder from directory tree.

You can access these folders under the Copy to/Move to menus.



One-Click Destinations

One-Click Destinations is another cool feature of Multimedia Xplorer. Usual Destinations menu is fast 
compared with every-time-browse-folder routine offered by other programs, but what about file sorting?

Here comes One-Click Destinations to help. It's floating resizable toolbar window, that displays all your 
Destination folders as buttons. By clicking on button, you simple copy/move selected file(s) to that 
folder. That's so easy!

You can control and switch from/between Copy/Move function by clicking appropriate button at the 
bottom edge of One-Click Destinations toolbar.

Also there is an additional feature called Popup Subfolders. If you mark your destination folder with the 
popup subfolder option in the Options dialog, then when clicking button, popup menu with all the 
subfolders of clicked folder will be displayed. That way, if you have special directory structure in 
destination folder, you can keep small number of Destinations and subfolder name changes are also 
automatically handled.

 To display or hide One-Click Destinations toolbar, click the 
 button.



Run With submenu

This submenu holds the names of programs you most frequently use to edit/manipulate files supported 
by Multimedia Xplorer. You can add your favorite image/sound editing programs here, so they are easily 
accessible. You can even define command line for each program, so it can complete specific task 
automatically.

 To display the Run With menu, click on the 
 button on the toolbar, or, choose the Run With item from the File menu.
 If no file is open, choosing a program just launches it without passing command line.



Tagging Files

Tagging files is a powerful feature that allows you to mark specific files for later use. Imagine you need 
to choose 50 files from 500-file collection and copy then into another folder. Now, if you will find the 
file(s) you would like to mark, you just "tag" it/them by pressing  which adds them into the list of tagged 
files. Later, if you have finished choosing files, you can see all the files you tagged by clicking the 

 button. That opens Tagged Files window, where you can manipulate (copy/move/delete etc) all those 
files at once. Otherwise you have to copy each found file manually that takes much more time.

Also, you have an option to display tagged filesnames with other color, so you can see them in Browser 
easily. To color tagged files in browser, use the  button on the toolbar. Please note that this slows 
down filling and refreshing filenames a bit.

Please note that you can also tag/untag files during the slideshow by pressing the T key.
If you want to remove selected file(s) from tagged files list, right-click on the  button. If one file is 
selected you don't need to right-click, but then the button acts like toggle - it's down when selected file is 
tagged.

To get help about specific items in the Tagged Files dialog box, press the  on window's caption and 
then click on the item.

 You can use Ctrl+T to tag and Ctrl+Shift+T to untag selected file(s).
 To clear the list of tagged files fast, right-click on the 
 button.



Configuring Multimedia Xplorer

Multimedia Xplorer lets you customize several settings. 

 To open the options dialog press the 
 button on the toolbar or press the keyboard shortcut Ctrl + O.

To get help about specific items in the Options dialog box, press the  on window's caption and then 
click on the item.

 To load default “factory” settings, use the Defaults button.



Tips

 To view open image quickly to full screen, double-click on it.
 You can drag files from Windows Explorer, desktop etc. and drop them into the Multimedia Xplorer 

window. If you drop into display area, the file is opened, if you drop into file list or directory tree, files you 
are dragging are either copied or moved to that folder (depending on source and your keyboard state).

 Click on the status bar to get count and size of selected/total in folder.
 Multimedia Xplorer has an additional function for copying HTML attributes of open image to the 

clipboard. If you choose Copy HTML Attributes from the Edit menu, Multimedia Xplorer places a string 
containing the image width and height into clipboard. It is useful when you are using an HTML editor, that 
doesn't fill image tags automatically with these values.
The string looks like: <IMG SRC="nimbus.jpg" WIDTH=640 HEIGHT=512 BORDER=0>

 Sometimes you may need to rotate or mirror an image before converting to the other format. The 
commands to rotate or mirror an image are located in the Edit menu.

 Sometimes you may need to copy a filename with full path to the clipboard. Multimedia Xplorer lets you 
do this, by choosing Copy Filename from the Edit menu. This works only if you are a file open.

 You can jump to filenames starting for example with the "K" by pressing the K key on keyboard while 
file list has input focus.

 To manipulate any files in file list without opening it first, simply right-click on it's filename and shell 
context-menu will appear where you can choose desired action, or, hold down the Ctrl key if you select 
filename.

 If you want to start Multimedia Xplorer in a spacial folder each time you open it, nevertheless what was 
the last browsed folder, you can add the folder name to the command line of shortcut file.

 You can right-click on some toolbar buttons to invoke special actions:
 Clear tagged files list
 Display the Slideshow popup menu
 Restore All Supported Files filter
 Set video speed to default
 If multiple files are selected, untags the files
 Please see Keyboard Shortcuts for useful shortcuts not listed in menus.



Keyboard Shortcuts

You can use many keyboard shortcuts in Multimedia Xplorer. Here are only listed keyboard shortcuts 
that are NOT visible in the menus.

 
To find out keyboard shortcut for the task, find out it's menu command and see if there is keyboard 
cobination for it. From the above image you see that shortcut for the Close File command is the Esc key 
and to display Properties dialog for selected file(s) you can use the Ctrl+Enter combination.

Additional keyboard shortcuts:

Delete file* Delete

Previous folder* Backspace

Desktop folder Ctrl+Backspace

Rename file in place* F2

Copy files* Ctrl+C

Cut files* Ctrl+X

Paste files* Ctrl+V

Change to drive "drive letter" Ctrl+Alt+<drive letter>

Zoom In Ctrl+Numpad +

Zoom Out Ctrl+Numpad -

Zoom Default Ctrl+Numpad *

Close program Alt + F4

*) File list must be focused, these keys are compatible with the Windows Explorer.

You can use some shortcut keys also during slide show. Please see special topic on this.



Changing User Interface Language

Multimedia Xplorer user interface is available in several languages. Some most used languages come 
with standard setup, but you can download other languages, if they are available, from our web site.

To change user interface language, follow these steps:

 Choose the Options command from the View menu.
 Activate the Language tab.
 Choose one of the available languages from the dropdown combobox.

Listed are only those language modules that are installed. Always is available English language, but 
others can be selected doring the setup procedure. You can run setup anytime to install more 
languages. Also, some other languages may be available from our web site.



Contacting Moon Software

 
If you have access to the Internet, be sure to visit Moon Software homepage. You can download the latest 
versions and updates of Multimedia Xplorer as well as some other cool programs. You can also order our 
programs from our online store.
URL for Moon Software homepage:
http://www.moonsoftware.com
E-mail address for information, feedback, suggestions, bug reports, support etc:

ahto@moonsoftware.com

Postal address:

Moon Software
Karja 2 - 58
Paide, 72717
ESTONIA (Europe)



Prices

Prices are subject to change. Latest prices are listed in our web site.

Licenses doesn't include disk with software. By purchasing license, you'll get registration number only, 
so you can register your existing shareware copy of Multimedia Xplorer (got from the Internet, BBS etc.). 
If you want to get also latest version of software on disk, choose license and disk with shipping.

single user license for new user $25 US

upgrade from version 1.x to version 2.x $12.50 US

software on 3.5" disk + air mail shipping $5 US

3-user license $65 US

5-user license $99 US

10-user license $189 US

site license** $499 US

educational site license*** $99 US

world-wide license**** $1999 US

(**) Site licenses cover a single organisation on single location (building complex). If you buy site 
license, you may use Multimedia Xplorer in unlimited number of computers of your company within this 
area.

(***) The same as above but for educational institutions only (schools, universities etc.).

(****) World-wide license covers all computers of single organization world-wide.

NOTE: All types of licenses contain one registration number.



Why Should I Register?

Multimedia Xplorer is not free software. This software can be distributed free of charge in it's 
unregistered form only, so everyone can try this product before he/she pays little license fee to the 
author. So everyone can really test it in own machine and can see if this program is useful for him or 
not.

Due to the very rigid license agreement between me and Unisys Corporation who owns the patent for 
the LZW compression technology used in the GIF and TIFF graphics formats, I'm not allowed to enable 
converting into these 2 formats in shareware version of Multimedia Xplorer. However, in registered 
version you can convert to the GIF and TIFF formats without any restrictions.

Unregistered version works 30 different days. This should be enough to get to know if it's suitable for 
you or not.

When you register, you will get (at reasonable price):

 you'll became registered user of Multimedia Xplorer and get registration number to unlock the 
shareware version

 converting to the GIF and TIFF formats
 free version-specific updates
 new versions for 50% of the regular price
 free technical support via e-mail
 a good feeling that you are honest and support shareware concept



How to Order?

Please see our web site for up-to-date info about ordering this product. See also prices.

If you are from Japan, you may contact Japanese distributor.

If you have no acces to the internet, you can send your order via postal mail and include cash (US 
dollars only). Please write clearly what program and what version you would like to buy. If you want to 
get the latest version shipped to you on the 3,5” disk via Air Mail, please add $5. You can also send a 
check, but then you must add another extra $5 for cashing international check. Checks must be payable 
to Ahto Tanner. Please see the prices and contact information for the address.



Japanese distributor

In Japan, this program can be registered from P. & A. Shareware. Payment can be made by credit card, 
bank transfer, COD, etc. Visit their web page (www.panda.co.jp) or contact them for more information:

P. & A. Inc.
No.3 Hoko Bldg. 6F
2-29-13 Akebono, Tachikawa
Tokyo 190-0012 JAPAN

tel: (042) 525-9501
fax: (042) 525-9502
web: www.panda.co.jp
e-mail: info@panda.co.jp
NiftyServe: PAF02461



After Getting Registration Number

After receiving your registration information (name and number) you need to enter it into Multimedia 
Xplorer. Once the registration information is entered the program is registered to you. To enter your 
registration information take the following steps:

 Choose Enter Registration Number from the Order! menu of Multimedia Xplorer. The Register dialog 
will show up.

 Type in your name and registration number EXACTLY the way they appear in the letter you received. 
Use the same capitalization as in the letter.

 After the registration information in entered, press the OK button. If your data was entered correctly, 
Multimedia Xplorer is registered to the name you entered. The Registration menu will be hidden and your 
name will be displayed in the About box. You are now the lawful owner of the program.

NOTE: Be sure to save the registration information you received in a safe place. You will need it again if 
you reinstall Windows. Better safe than sorry.



Cannot Play Video/Sound Files

If you have problem playing multimedia files, please do the following:

1. Try the ActiveMovie Repair Wizard to automatically repair your MCI configuration.

2. If that doesn't solve the problem or it tells you have no ActiveMovie installed, then get latest MCI 
drivers.

3. If you have tried the steps above and have still problem, please contact us and describe, what you 
want to do, what error message you see and send us also your system information (use the Copy 
System Information command in the Help menu of Multimedia Xplorer).

See also:

How to obtain MCI drivers



ActiveMovie Repair Wizard

ActiveMovie Repair Wizard is a little helper that solves some problems for you. If you have installed 
ActiveMovie to support viewing sound and video files through Multimedia Xplorer but still have 
problems, run the wizard and it can most likely resolve your problem:

 To run the wizard, choose the ActiveMovie Repair Wizard command from the Help menu of Multimedia 
Xplorer.

The wizard window lists the file types ActiveMovie supports. All types that are currently successfully 

associated with ActiveMovie are marked with a green check mark . You cannot remove the check 
mark nor change the driver association for those items. If you see some entries that have no check 
mark, then these types are not currently associated with ActiveMovie. It's recommended that you 
associate all listed types. That ensures you can see most of files you have through Multimedia Xplorer.

If you don't know much about drivers, file types etc, you can use the Auto-Fix! Command to 
automatically associate all file types with ActiveMovie.

If you want to manually associate only some of all available types, double-click on an entry to associate 

it with ActiveMovie. The red  check mark is displayed for each item that waits repairing. For example 
if you had problem viewing MOV files with Multimedia Xplorer, then you should check the MOV file type. 
If you have checked the types you would like to associate (repair), then press the Fix Selected button. 
Follow the instructions on-screen.

If the wizard caused problems in your other applications, you can restore the changes it made last time. 
Just choose the Restore command. It's good if you can restore your configuration as soon as possible if 
something didn't work properly after repairing.

See also:

How Multimedia Xplorer plays sound and video files.



Some functionality requires updated ComCtl32.dll

Currently the Flat toolbar, Auto-expand/collapse folders and Color tagged files in Browser options 
require updated system file ComCtl32.dll. Usually most systems already have this updated file, 
distributed by many applications. If you have no right version of this file, these options are disabled in 
the Options dialog.

You can download the updated file from our homepage Support section, or directly from Microsoft:

http://www.microsoft.com/msdn/downloads/files/40comupd.htm



Setting Display to High Color

Before making any changes to your display mode, please write down your current settings so you can 
restore them later! Also, if you don't know about display settings, it's best you can consult with someone 
who knows and configures it for your. There is possible to change settings so that you don't see proper 
picture later.

1. Click here  to open the Display Properties dialog.

2. Choose the Settings tab.
3. Note the settings there: the Colors combo-box shows your current number of colors. If you have "high 
color" or "true color" there, you are already running in appropriate display mode, so no changes 
necessary.
4. Note the Screen area settings at right side. If there is "high color" or "true color" choices available in the 
Colors combo, choose one of them (try "high color" first). If now your Screen Area settings were changed, 
you don't have enough video memory on your graphics adapter to display "high color" at specified display 
resolution. You can try your new settings by pressing the OK button.

If something went wrong, please change your settings back to your previous configuration.



Uninstalling Multimedia Xplorer

Removing Multimedia Xplorer from your system is very easy. This will remove the program itself from 
your hard disk as well as the settings in the registry.

 Click here 
 to open the Control Panel Add/Remove Programs applet.
 Find out the Multimedia Xplorer 2 (Remove Only) entry in list and select it.
 Close this Multimedia Xplorer help file you're reading. Otherwise uninstaller cannot delete it from your 

system.
 Press Add/Remove button to start removing the application and follow the instructions on screen.



License Agreement

Please click  to display License Agreement.



Credits

Many thanks for all folks who have helped me in testing, checking, proofreading, implementing 
Multimedia Xplorer!

Multimedia Xplorer is written with Inprise Delphi.

Special thanks goes to the folks who have translated the user interface (in random order):

Norwegian translation by Bjornar Nygard:
e-mail: bjonyga@online.no
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Italian translation by Gabriele & Michele Venturi
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French translation by Arnaud Malapert
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Portuguese translation by Bruno Sonnino, from Brazil:
e-mail: sonnino@netmogi.com.br
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This product contains portions of imaging code owned by Pegasus Software LLC and Pegasus Imaging 
Corporation. Check their web site at www.pegasusimaging.com for digital imaging tools.

Multimedia Xplorer is dedicated to all peaceful people from all over the world…

Ahto



Differences Between Lite and Full Version

There are several versions of Multimedia Xplorer. Besides the standard version available for downlaod 
from the Internet, there are special Lite and SE versions, that are bundled with other software and 
hardware. Here are listed differences between those versions and full version. Full version has none of 
these limitations:

Lite SE

No GIF and TIFF image 
displaying
No Batch Conversion
No Slideshow
No One-Click Destinations
No Batch Rename
No Logo Changer
No Set Wallpaper
No printing
Convert to BMP only
No video playback speed 
adjustent

No GIF and TIFF 
image displaying

If you are interested in obtaining a full version of Multimedia Xplorer that has no limitations, please see 
the prices (cheap!) and ordering topics. Also, you can download the evaluation version to try the full 
version for 30 days.



Press the  button in the dialog's title bar and then select the particular item you want help with.



Here you write the name that will appear in the menu for the program you are adding.



Here you specify the command line for the program you are adding. You can browse for executable files on your 
system by clicking the [...] button next to this field.

You can add command line parameters that will be passed to the program, e.g. if you can use yourprog.exe to print 
an image with the /PRINT switch after filename, you can use the following command line to print open image using 
this program:

C:\YourProg Folder\Yourprog.exe "%FN" /PRINT



If this checkbox is checked, filename passed to a program is converted to 8.3 filename. This option is generally for 
compatibility with 16-bit programs, that know nothing about long filenames and truncate a name at the position of 
first space.



Brings up the Browse for Folder dialog, so you can pick your folder quickly.



Closes the dialog without converting images.



Opens second instance of Multimedia Xplorer and points it to the target folder. This way you can check out what 
files are in the folder.



Displays the Options dialog with the Conversion tab, so you can adjust conversion options.



Starts batch conversion with the options selected.



Allows you to resize images. All target images will have the dimensions you enter.



Overwrites files in target folder, if files with the names of our converted files already exist. If this checkbox is not 
checked, no files will be overwritten, but entry is added to the conversion log.



Choose the color depth for converted images. This way you can force Multimedia Xplorer to increase/decrease 
color count for converted images, compared to original images. Automatic uses color depth of source image, if 
possible.



Write here the name of the folder where you want converted files will be placed. You can use the Browse button 
right and browse your folder instead of typing.

 To use current folder, that is active in browser, leave this box empty.



Images will be converted into the file format you choose here.



Width and height of images. You must have the Resize Images checkbox checked to modify these values.



This setting allows you to modify the filenames of converted files. For example if you are making small thumbnail 
images, you may want to add the prefix "thb_" to all new images. Then you write the "thb_" (without quotes) into the 
Prefix text box.



Prefix and Suffix of new filenames. This is useful if you want the modified filenames to be slightly different from the 
source names. For example if you are making small thumbnail images, you may want to add the prefix "thb_" to all 
new images. Then you write the "thb_" (without quotes) into the Prefix text box.



This option lets you control how images are resized. If it's checked, image keeps right aspect ratio, so one side may 
remain smaller than specified, but image looks nice (keeps right proportions). If you want images to be exactly the 
size you entered, uncheck this option.



If this option is selected, small images are allowed to resized to larger width/height. Otherwise if image is smaller 
that selected dimensions, it will retain original dimensions.



Write here the template you want to use for your filenames. For example you have source images called 
mountain.jpg, forest.jpg and clouds.jpg. You want to rename them as series: views001.jpg, views002.jpg, 
views003.jpg. Then you must write views### as the template.

 To remove extension from files, end your template with one dot.
 To force rename of file extensions, write the new extension to the template.



Numbering starts from the number written here.



Displays original and new filenames, so you can experiment with your template and see immediately changes to 
the filenames.



This option finds new free number on filename collision. For example you already have File003.jpg in the target 
folder, then it is not overwritten, but Multimedia Xplorer finds next free number.



Check this if you want to overwrite any file in target directory that may have the same name as some of source 
files. Handle with care!



Marks all file types in the file types list.



Unmark all file types in the file types list.



Allows you to load default settings for all pages or current page in the Options dialog.



Opens a dialog that helps you to add new entry to the list.



Moves selected entry in the list down or up by one position. 

 You can also reorder the entries with the mouse.



Removes selected entry from the list. 



Sorts entries in the list in ascending order.



Opens a dialog where you can change the options of the currently highlighted item.

 You can also double-click on an entry to open an editing dialog.



Adds the Multimedia Xplorer entry to the context-menu of folder objects, so you can open Multimedia Xplorer from 
Windows Explorer and point it to the folder of interest with one click.



Makes Multimedia Xplorer entry to the SendTo submenu in file and folder context-menus. That way you can send 
files into Multimedia Xplorer from Windows Explorer with ease.



Allows you to see flat toolbar instead of standard buttons. Flat toolbars are used in Internet Explorer 3 and newer, 
in Office 97 etc.

NOTE: If this function is disabled, you need an updated system file.



Allows you to minimize Multimedia Xplorer into the system tray area in taskbar.



Specifies whether the folder nodes in the directory tree automatically expand and collapse depending on the 
selection. When this option is set, previously expanded folder collapses if you select new one. This makes 
navigation in the directory tree a bit easier.

Note: If this function is disabled, you need updated ComCtl32.dll system file.



If you want to launch associated program if you double-click on a filename in the Browser, then check this 
checkbox. If this is unchecked (default) then nothing happens on double-clicking a filename. Then you can still 
launch associated program if you right-click on filename and choose the command from the popup-menu that is 
painted with bold typeface.



Marks selected directory so that in One-Click Destonations toolbar, by clicking on this directory, a list of it's 
subfolders will pop up and you can copy/move files(s) into the subfolders with ease.



Check this if you want your images are displayed in random order during the slideshow.



Check this item if you want your slide show to loops endlessly until you break it by hitting the Esc key. Otherwise 
your show is displayed only once and after finishing it's closed.



Saves Browser's filelist state (Large Icons, Small Icons, List, Details) between sessions.



Saves main windows maximized state between sessions.



Here you can specify whether you want to see file information during a slide show or not. File info includes file 
name, size, dimensions and color resolution.

 You can switch file info on/off during the slideshow by pressing the I key on the keyboard or by choosing Show File 
Info from the popup menu.



Shows or hides folders in the file list in browser. You can use this functionality also from the View menu Show 
Folders in Browser item, or, by the Shift+Ctrl+F combination.



If checked, Tagged Files form will be displayed after the slideshow, if during the show some files are 
tagged/untagged.



Restores last used file filter next time Multimedia Xplorer is launched.



If checked, deleted files will be sent to the Recycle Bin, otherwise they will be deleted immediately. If they are in 
Recycle Bin, you can undo your Delete/Move/Copy actions from Windows Explorer.

 To delete files immediately even if default setting is to use the Recycle Bin, hold down the Shift key while choosing 
file operation.



This is 3-state checkbox.

If checked, all images are displayed during the decoding process, so you see how image decodes. However, in 
256-color mode, it's not nice effect to se how palette for image changes. Since palette for non-palette images is not 
known until the image is decoded completely, it is realized after image is decoded. That causes flashing.

If unchecked, image decoding is never visible. If you don't like to see image decoding, use this setting.

If grayed, then Multimedia Xplorer itself decides, when do display decoding and when not. That's the default 
setting and the best setting for most users.



This list allows you to mark files you want to associate with Multimedia Xplorer.



Here you can choose the icon to display in Windows Explorer for files associated with Multimedia Xplorer.



This button invokes a dialog for selecting background color for images displayed full screen. Current background 
color is visible on the button.



This button invokes a dialog for selecting the background color of slide shows. Current background color is visible 
on the button.



Here you can specify an amount of time, that one slide is visible, in seconds. Minimum time is 1 second.



This list box lists the current entries in the Custom Filters menu. To add an entry, press the Add button; to remove 
an entry press Remove. To edit an entry press the Edit button or double-click on it.



This list box lists the current entries in the Destinations menu. To add an entry, press the Add button; to remove an 
entry press Remove.



This list box lists the current entries in the Run With menu. To add an entry, press the Add button; to remove an 
entry press Remove. To edit an entry press the Edit button or double-click on it.



This list box lists the current entries in the Favorites. To add an entry, press the Add button; to remove an entry 
press Remove.



You can choose automatic or manual slide show. Automatic shows you all slides in the show automatically, and in 
manual mode, you can view next slide by clicking the mouse or by pressing the spacebar, so you don't have to wait 
a certain length of time. You can also switch the mode during a slideshow.



Write here your boot drive letter, where logo changer can place logo.sys startup image file. If you have only one 
hard disk in PC and you have not compressed it with DoubleSpace, this drive is usually C. But if you have 
compressed your hard disk with DoubleSpace or Stacker, you must write here the drive letter of the host drive, 
usually H.



This feature enables you to see small images enlarged during a slideshow. If you are displaying relatively small 
images, then enlarging them to whole screen size distorts them so they are not looking good any more. Here you 
can tell Multimedia Xplorer, how much it can enlarge small images.



Lists the different TIFF compression formats you can choose while saving an image into TIFF format.



Changes JPEG quality. 100 is the best. A lower level causes a smaller file size, but poor image quality. Default is 
80.



Check this if you want Multimedia Xplorer will save it's maximized state while closed. Next time it is opened in 
maximized state again, if it was left so last time.



Choose the color for tagged files. Then in the Color tagged files in Browser mode all your tagged filenames will be 
this color so you can easily determine what files are tagged.

Note: If this function is disabled, you need updated ComCtl32.dll system file.



This is a troubleshooting option if you have problems displaying shell context-menus when you right-click on file or 
folder object(s). Some context-menu extensions use undocumented hook functions to draw images in context 
menu and that may cause problems if context-menu is displayed outside Windows Explorer. If you get an error 
message or Multimedia Xplorer hangs when you try to display context-menu, set this option to disable shell context-
menus.



By pressing this button a popup menu will appear where you can choose several actions to perform on the 
currently open show file.



Adds the filenames selected in the file list to the currently open slide show.

 You can also add files by double-clicking on the filename in the file list.



Adds all files in the file list to currently open slide show.



Lets you open and append another saved slide show file to the currently open file.



Closes the slide show editor window.



Creates new, blank slideshow.



Opens a saved slide show file so you can edit it.



Plays the currently open slide show. You can use this button to test the show you are creating.



Removes selected files from the slide show.

 You can also remove files by double-clicking on the filename.



Removes all files from slide show.



Saves the currently open slide show. Can also be used to save your slide show with a new name.



Check the Preview checkbox if you want to see small preview of selected image. 

 You can double-click on preview windows to see the image full screen.



Here you can change the filter that allows the viewing certain type in the file list. If you want to see only bitmap files 
with extension BMP, choose BMP here.



Favorites combo box. You can pick your favorite directory here with single click.



Here is a list of files that are in the slide show. To remove a files, double-click on it.

 You can take do many actions to files in a show by pressing the Actions button. The same popup menu will opened 
it you right-click on the list.



Write here the text string you want to replace.

If you want to change the drive letter from e: to c: in all the filenames, write here e:\ and in field Replace with write 
c:\      .



Write the text string here that you want to find.

If you want to change the drive letter from e: to c: in all the filenames, then in the Replace what field write e:\ and 
here write c:\     .



Tells Multimedia Xplorer to generate image strip containing all images in the icon file. Image strip is similar you can 
see in the main window, when browsing icon files with multiple images.



Choose a background color for image.



If you want to add border to the image, set border size here. To remove border specify 0.



Adds (+) or removes (-) current folder to/from the list of favorite folders. There is separate favorites list for Logo 
Changer.



Closes Logo Changer windows without making modifications to your logo files.



By pressing this button, you update your startup & shutdown images that you've changed.



Opens Save Logo Set dialog.



Lists your favorite folders containing images for startup/shutdown logos. You use +/- buttons to add/remove 
selected entries from this combo-box.

NOTE: These favorite folders are not associated with the main Favories. They work similar, but changes made to 
the main favorites list won't change these logo favorites and vice versa.



Choose to display image files or logosets.



These are thumbnails of your startup & shutdown images. To load a new image instead of existing one, first select 
image placeholder and then click on the file you want to load. You can also right-click for popup-menu, from where 
you can choose to view it full screen or save it to file.



Displays popup menu with additional actions you can take on files in the list.



Closes the dialog.



Copies tagged files to the location you choose.



Moves tagged files to the location you choose.



Deletes tagged files.



Clears the tagged files list automatically after file operation (copy/move or delete).



Lists all tagged files. To remove items from the list, select item and press the Del key. Right-click for the Actions 
popup menu.



Loads default settings for printing.



Starts printing with the specified settings.



Displays Windows's Printer Setup dialog. You can select landscape or portrait mode and other printer options there.



Displays small help window listing all the variables you can use in title.



Allows you to specify margins if Fit to Page is checked and Max Image Size is not checked. These are margins 
from paper edge.



Allows you to set image left and top position in given units. This item is disabled if either Center Vertically or Center 
Horizontally item is checked.



Check this if you want to print image as big as printer supports.



Check if you want to center image on page vertically or horizontally.



Uncheck this is you don't want to see image in preview, only printer margins.



This displays or hides unprintable area margins.



Check this if you want to print title at the bottom of page.



Write here the title you want to print at the bottom of page. You can use several variables in the title to print current 
filename, date etc. Please press the [?] button at the right side of this combo-box to get listing of variables you can 
use.



Allows you to change the units displayed. Currently supported are either inches or millimeters.



Choose number of copies of this image you want to print at once.



You can use the Zoom box to set the size of image. Value 100 means 1:1, 10 means 10 times smaller than original. 
See preview how it looks on paper.



Displays Options dialog where you can change some file type conversion settings, like JPEG compression ratio etc.



Favorites let's you go to your favorite folder with a click of mouse. You can edit contents of Favorites in the Options 
dialog.



Choose color depth of target file, or leave it Automatic to use color depth from source file.



If checked, you can adjust target image dimensions. You can resize only bitmap images, excluding icons, cursors 
and Windows startup/shutdown logo files.



Width and height of your target image. You can make your new image smaller or larger than original. To keep right 
proportions from the source image, check the Keep Aspect Ratio checkbox below.



Checking this checkbox allows you to automatically calculate new height or width if you enter one value.






